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EMMA  
MATTHIEU FREYERMUTH 

This beautiful portrait 
illustrates many of the 

techniques we describe in 
this week’s main feature. The 

eye-level vantage point helps 
the viewer connect with the 
subject, and as a result the 
child is fully engaged with 

the camera. We also love 
the high-key lighting

TAKEN WITH: Canon EOS 5D 
Mark III with 50mm lens

EXPOSURE: 1/100 sec 
at f/1.4, ISO800

http://tiny.cc/gvro0x



JOIN THE CLUB...
Welcome to the world’s  
No.1 weekly digital 
photography magazine. 
If you’re already a 

reader, thanks for your continued 
support and involvement; if you’re 
new to Photography Week, you’ve 
come to the right place! In addition 
to expert advice, brilliant tips and 
step-by-step tutorials, every issue 
features interactive galleries of the 
best new photos, how-to videos on 

essential shooting and editing 
techniques, and in-depth video 
reviews of the latest cameras. 

But that’s not the whole story. 
Photography Week is more than 
a magazine – it’s a community 
of like-minded people who are 
passionate about photography. 
To get involved, just follow any 
of the links below and share your 
shots and comments – your photo 
might even appear on our cover!

W E L C O M E

We’re more than just a magazine – read on and discover the many  
ways you can interact with and enjoy Photography Week

JOIN THE PHOTOGRAPHY WEEK 
COMMUNIT Y AND START SHARING! 

FACEBOOK
http://tiny.cc/bljpjx

TWITTER 
http://tiny.cc/hmgpjx

FLICKR 
http://tiny.cc/8kgpjx
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W H AT ’ S  H O T
THE WEEK’S TOP HEADLINES IN PHOTOGRAPHY

SN E W

S
erif is best-known for its 

budget Windows 

image-editing, illustration, 

web design and layout tools. Its brand 

new Affinity range, though, is designed 

solely for Macs, and is aimed squarely 

at professionals photographers.

Affinity Designer, Serif’s brand 

new professional graphic design and 

illustration tool, was the first Affinity 

product to arrive, in October 2014, and 

scored a Mac App Store ‘Best of 2014’ in 

the process. Affinity Photo, announced 

in February 2015, uses the same core 

processing engine, and aims to do for 

Affinity Photo is 
subscription-free and 
comes with an old-
school ‘perpetual licence’

SERIF 
LAUNCHES 
PHOTOSHOP 
RIVAL AT 
ONE THIRD 
OF THE PRICE

image editing what Affinity Designer 

has done for illustration and vector art.

Many so-called Photoshop 

rivals are actually much more basic 

consumer-orientated editing tools 

aimed at beginners, but Affinity Photo 

is the real deal. It offers key tools and 

technologies essential in a professional 

environment, including 16-bit editing, 

RGB, CMYK and LAB color modes, 

ICC color profiles and raw image 

development. It can also import and 

export Photoshop PSD files.

Its layout and operation is similar to 

Photoshop’s, with a clean and simple 

vertical tools panel on the left of the 

screen and stacked (detachable) 

palettes on the right. It takes some 

acclimatization after Photoshop, but 

the basic principles of layers, masks, 

selections and adjustment tools are 

the same. The difference lies in Serif’s 

processing engine, which has been 

designed to exploit the full potential of 

today’s 16-bit hardware with fast, real-

time adjustments that show changes 

‘live’ as you work so that you don’t have 

to close a dialog first or wait for the 

image to redraw.

The low price may pitch Affinity 

Photo with a whole bunch of other 

Photoshop wannabes, but it’s a very 

different, much more powerful product 

that just happens to be cheap!

Affinity Photo is being sold on the 

Mac App Store for £39.99/$49.99.

Its price is almost less than one third 

of the cost of a one-year subscription to 

Adobe’s Photography Plan. The Adobe 

plan includes both Photoshop and 

Lightroom, but not every photographer 

will want to use both, and many still 

resist the idea of paying subscriptions to 

‘rent’ an application.

The Raw Develop module offers localized edits, 
just like Adobe Camera Raw. Serif's been quick 
to add support for new cameras

 
rearranging the planes in an architectural shot
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GoPro has lately been dipping 
its feet in virtual reality, having 
recently partnered with Google 
on a 360-degree VR camera rig, 
but the action cam company isn’t 
looking at VR as a passing fad. 
Quite the opposite, actually.

“VR is gonna open up all kinds 
of viewing experiences, and 
expand the lifespan of content,” 
said GoPro CEO Nick Woodman, 
who spoke with Mashable. “VR 
is a whole new experience that 
can fully transport someone into 
another experience.”

Unlike 3D, VR isn’t a gimmick, 
the CEO said. GoPro is already 
making spherical cameras, or 
rather, rigs that use its current 
line-up of cameras.

“We are positioned more than 
any other camera company to 
enable VR,” Woodman said, and 
with the release of the smallest 
GoPro yet, the company could be 
looking to make portable rigs for 
360-degree VR footage capture. 
Goodman has previously hinted 
that GoPro is looking to release 
its own drones or quadcopters 
next year. “People are getting 
into quads not because they like 
flying little quads around, but 
because they want the incredible 
content that a GoPro and a quad 
enables,” he told Mashable.

No details on the GoPro 
drones or quadcopters have 
been officially announced, but 
we should start hearing news 
starting from the beginning of 
next year.
www.gopro.com

GOPRO SAYS 
VIRTUAL 
REALITY ISN’T 
A GIMMICK, AND 
IT’S THE ONE 
FOR THE JOB

I
f you’ve always wanted to buy 

a GoPro camera, but you were 

put off by the advanced, 

pro-level functionality found in GoPro’s 

HERO4 Black, you’re in luck – GoPro has 

announced its most user-friendly 

camera ever: the HERO4 Session.

Operating the HERO4 Session is 

easier than it is on any of GoPro’s other 

cameras, with a single button used to 

perform the majority of its functions. 

A short press of the shutter button turns 

the camera on, starting video capture 

automatically, a longer press powers 

the camera on and switches it to Time 

Lapse photo capture mode, and you 

only have to press the button once 

more to save your recording or photo 

and turn it off again.

Just like with previous models, 

you can further refine your 

controls and settings by 

using the GoPro app or 

Smart Remote.

The HERO4 Session 

is 50 per cent smaller 

and 40 per cent lighter 

(74g) than GoPro’s 

HERO4 Black and Silver, 

at roughly a cubic inch in size, and has 

a Micro SD card slot, a non-removable 

battery (two hours on a full charge), 

built-in Wi-Fi and Bluetooth and a Micro 

USB port, so you can keep it going 

indefinitely. It’s also waterproof to a 

depth of 10 metres, without the need 

for an additional case or dive housing, 

although it does come with standard 

and low-profile mount brackets, as 

well as a new Ball Joint Buckle mount. 

The HERO4 Session is also compatible 

with all existing GoPro mounts and 

accessories.

The HERO4 Session retains GoPro’s 

signature high-quality image capture 

capabilities, recording 1080p video 

at 60fps, 720p at 100fps and 1440p at 

30fps (those after 4K video will have to 

opt for HERO4 Black), along with eight 

megapixel photos in its Single, 

Burst and Time Lapse modes.

The GoPro HERO4 

Session hits the 

streets on July 12 

for $399/£329, 

the same price 

as GoPro’s 

HERO4 Silver.

GoPro’s new camera is a no brainer to operate

GOPRO UNVEILS HERO4 SESSION, 
I TS SMALLEST ACT ION CAMERA YET





Turn your living room into a portrait studio and make stylish 
image compilations of the kids you’ll treasure

CREATE GREAT
CHILD PORTRAITS

T  oddlers and babies are 
photographed by parents, 
relatives and family friends with 

a frequency usually reserved for A-list 
celebrities. But if you want your child 
photos to look more refined than the 
average snap, a little more care and 
attention is required. So we’ll show you 
how to transform your living room into 
a makeshift studio, then present your 
images in an eye-catching compilation.

Successful compilations are all about 
balance. For color images, it’s a case of 

pairing colors that don’t clash, whereas 
in black and white, a balance of light 
and dark is important.

For example, if a couple of images 
are dominated by dark tones, placing 
them opposite one another will balance 
the overall look. The same balance 
works for composition. If, for example, 
a person is looking to the side, then it’s 
best to have them looking inwards, and 
ideally, you’d use a shot taken from the 
other side to sit opposite. For a grid of 
images like this, compositional triangles 

can work well. Notice how there’s 
a triangle of darker-toned images 
(bottom-left, top-middle, bottom-right), 
and one of lighter images (top-left, 
bottom-middle, top-right).

We’ll show you how to make a 
compilation with simple layer skills and 
clipping masks to crop the images. It’s a 
smart way to work, because we’re free 
to tweak the crop of each frame at any 
time, which is handy when we want to 
try out different image combinations 
and fine-tune the overall balance.

UT R EF E A



DARK BACKGROUND
Unpatterned blankets and sheets are 

very useful for portrait shoots. You 
can either get the child to lie on them, 
or instead prop them up for a clean, 

simple background. Textured material 
can work well – children like the feel of 

them on their skin, and textures become 
more important when converting to 

monochrome.

1
WHITE UMBRELLA

The larger a light source, the softer 
it becomes. Flashguns have a 

small source, so the light is hard 
and unflattering. A white umbrella 

transforms the harsh, unflattering light 
into a bank of beautiful soft, diffused 

illumination. Attach your flash to a tripod 
using the thread in its stand, then rig the 

umbrella in front of it.

SHOOT OPPOSITES
Symmetry works well in compilations, so 
plan ahead during the shoot. If you take a 
shot of the child looking to one side, make 

sure you get another looking the other 
way. When presented together, they’ll 

create a pleasing symmetry. For side-lit 
shots, position the flash to the side and 

slightly behind the face.

2
WIRELESS TRIGGERING

Cameras with wireless flash and 
compatible flashguns make wireless 

triggering a breeze. Open your pop-up 
flash, set your flash mode to manual 
flash and choose an output power. 

Set your flashgun to wireless and the 
pop-up flash will trigger the flashgun 

wirelessly and communicate the power 
through a series of pre-flash bursts.

WIDE APERTURE
The great thing about using flash is that it 
allows you to control the depth of field. 

A high flash power combined with a 
narrow aperture gives you more depth of 
field – perfect for full body or headshots. 
A low flash power and a wide aperture 
gives a shallow depth of field, ideal for 

isolating details like the lashes here.

3

CAMERA SETTINGS
When using flash, the high light levels 

mean you should always set your ISO to 
100 for the best quality. You’ll need to be in 
manual mode with your shutter speed set 
to about 1/200 sec. Set the aperture to f/11 

and take a test shot. If it’s too dark, open 
the aperture or increase the flash power. 

If it’s too bright, do the opposite.

4 65

2

1
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TRANSFORM 
YOUR LIVING 
ROOM INTO 
A PORTRAIT 
STUDIO 
All you need for great 
portraits is a Speedlite, 
a white umbrella and 
a simple background

SHOOT CHILD PORTRAITS

UT R EF E A



WORK OUT THE SIZE YOU NEED
Begin by working out a size for the compilation. We want 

inches. Open Elements and go to File>New> Blank Document. Set 

ADD A SQUARE
 Go to Edit>Preferences, select Guides and Grid, then set 

tool options. Press D to set the foreground color to black, then 

FINISH THE LAYOUT

make a copy. Position it to the side with one inch between, then 

frame, drag the bounding box to make it rectangular.

ADD AN IMAGE

Open all the images you intend to use in Elements. Go to the 
Photo Bin and choose Show Open Files, then double click the 

drag an image into the document window from the Photo Bin.

1 2

3 4

STEP BY STEP: EDIT YOUR CHILD PORTRAITS

UT R EF E A

TOP TIP A QUICK WAY TO COPY LAYERS
The Alt key is a useful shortcut for copying items in Photoshop. Hold down Alt and drag any layer, 

 
 



CLIP TO THE SQUARE

turning it into a window for the underlying image. Click the 
bounding box to resize and rotate the layer until you’re happy.

CONVERT TO MONOCHROME
Highlight the top layer and click the Create 

adjustment layer icon in the Layers panel. Choose Gradient 
Map. Set Gradient: Default. Press D, then X to reset the swatch 

Foreground to Background preset.

FILL THE REMAINING BOXES

them once they are in the document, simply drag them with the 

selection. Make a new layer at the top of the stack, then go to 

INVERT THE BACKGROUND
If you want to prepare each image for printing separately, 

black background: highlight the Background layer and press 

TOP TIP GET EYE-LEVEL

STEP BY STEP: EDIT YOUR CHILD PORTRAITS

UT R EF E A

5 6

7 8



N
ewborn babies are 
also ideal subjects for a 
compilation. Of course, they 

aren’t able to pull many poses, and their 
array of expressions could be quite 
limited (especially if they’re asleep), 
so to add variety to the compilation, 
shoot details like little fingers, toes, 

and lashes. Not every image needs to 
include the face!

If parents don’t want to be in the 
picture, you could still make use of their 
hands and arms to hold the baby and 
give your image a sense of scale next 
to the tiny body. Babies might be a little 
wary of flash, so you could try using 

window light instead. The images here 
were all taken with the light from a large 
bay window.

Window light is less strong than flash, 
so you’ll need to use a higher ISO, but 
the images in a compilation are usually 
quite small, so you don’t need to worry 
too much about noise.

UT R EF E A

NEWBORN BABIES



Everything the Canon 
photographer needs!

A comprehensive reference guide 
to your Canon EOS digital SLR



AVAILABLE ON YOUR DEVICE NOW!

To find out how you can get Photography Week delivered straight  
to your device every week for just a few pennies, simply search  

for Photography Week on any of the platforms below

SUBSCRIBE TODAY AND ENJOY 
PHOTOGRAPHY WEEK FOR 
JUST 39C/39P AN ISSUE*  

S U B S C R I B E

http://tiny.cc/6x3xkxhttp://tiny.cc/613xkx http://tiny.cc/bz3xkx http://tiny.cc/ly3xkx

*Available for a limited time only. Standard subscription offer varies across platforms/devices – please refer to specific store for the most up-to-date offer
* * Photography Week is compatible with Kindle Fire HDX, Kindle Fire HD, and Kindle Fire (2nd Gen). It is not compatible with Kindle Fire (1st Gen). 

* * 



X P O S U R E
THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

THE DARK WOODS 
FERGAL GLEESON 
Forests are always difficult  
to photograph, but Fergal  
has captured a wonderful, 
moody exposure
http://tiny.cc/gxcn0x



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

TAKE AWAY 
EDDIE CHEUNG 
Eddie has used a keen eye and 
clever focusing to create a 
splendid image that makes the 
viewer do a double-take!
http://tiny.cc/8xcn0x

INSECT 
JOSE LOPEZ 

Jose’s brilliantly close 
macro image is teeming with 

colors and fine detail
http://tiny.cc/vycn0x



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

FARM IN THE MIDDLE 
OF NOWHERE 
ARTUR SZCZESZEK 
Artur waited for the perfect light. 
The low perspective emphasizes 
the vastness of the scene
http://tiny.cc/4ycn0x

TREES 
IAN HOUGHTON

We’ve seen sunsets, but not like 
this one! Ian has framed the sun 

perfectly behind the trees to 
capture its stunning, golden light

http://tiny.cc/zzcn0x



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

PIER END 
DAVID BALL 
David’s perfect long 
exposure has smoothed over 
the sea and nicely blurred 
the clouds
http://tiny.cc/h0cn0x

RED ARROWS 
CALVIN TAYLOR LEE 

This might be the most 
original image we’ve seen all 

year. Such a clever idea
http://tiny.cc/e1cn0x



THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS!  
Taken a portrait you’re particularly proud of? Shot a sensational sunset you’d like to 
show off? Then join the Photography Week Facebook community and share your best 
photos today! You’ll get feedback from fellow readers and the Photography Week 
team, plus the chance to appear in Xposure, or even on our cover!

FACEBOOK
http://tiny.cc/bljpjx

FLICKR 
http://tiny.cc/8kgpjx

MARINE 
YANN WILLIAM 

Yann’s beautiful black-and-white portrait emphasizes his 
subject nicely thanks to the perfect background blur

http://tiny.cc/41cn0x



E
ven if you live in mundane 
surroundings, storms and 
lightning can make dramatic 

images. But capture them in a 
jaw-dropping location and you can get 
a very special image indeed.

Los Angeles-based photographer 
Evan Halleck got some amazing 
timelapse pictures of a storm breaking 
over the Grand Canyon during a recent 
stop over. “I saw that a storm was 
forming way in the distance, so I drove 
towards it,” he explains in an article on 
PetaPixel.com. “I was scared, but my 

How many times have you been driving along and seen a storm brewing, but not 
known how to do it justice? Take inspiration from photographer Evan Halleck

whole life I have always wanted an 
epic storm photo.”

Halleck has worked on nature 
photography and timelapse projects for 
about five years, so he didn’t need to 
waste time working out what gear and 
settings to use. Once he was at the best 
spot, he took a picture every five seconds 
for two hours, then a photo every second 
for the last 20 minutes. He ended up with 
1,200 raw files, from which he created a 
54-second timelapse film of the storm 
breaking. Why not have a go at timelapse 
shooting the next time you see a storm?

I T ’ S  C O O L ,  T H AT
THE BEST THING WE’VE SEEN THIS WEEK

I N S P TI R A OI N

A GRAND DISPLAY OF POWER

SEE THE V IDEO  
ht tp: // t iny.cc /uek f 0X



C R A S H  C O U R S E 
ESSENTIAL PHOTO SKILLS MADE EASY

S K I L   L   S

Want a really fast lens, but can’t afford one? Then 
have a go at the Brenizer effect, says Chris George

BIG UP BLUR WITH A  
BOKEH-RAMA EFFECT

Do you dream of owning a 
really wide aperture lens 
that enables you to shoot 
pro-quality portraits with 

beautiful bokeh? The Brenizer effect is 
an ingenious way of minimizing depth 
of field. Invented by photographer Ryan 
Brenizer, it uses a panoramic stitching 
technique – where you shoot lots of 
telephoto pictures of different parts of 
the scene, each with the same limited 
depth of field. You then join this mosaic 
together on your computer using photo-
editing or specialist stitching software.

90
MIN

Also known as a portrait panorama 
or bokeh-rama, the Brenizer 
effect enables you to create 
a wide-angle scene with an 
unbelievably narrow depth 
of field, with beautifully 
blurred bokeh in the 
foreground and background. 
The result is much more 
convincing than using 
Photoshop Blur or Tilt/Shift trickery. 
It’s a great technique for shots of 
couples, making it popular for wedding 
and engagement portraits.



STEP BY STEP: GET THE BRENIZER EFFECT

S K I L   L   S

GRAB YOUR  
TELEPHOTO

Choose a mid-telephoto 
lens setting and use it at 

its maximum aperture. Pros 
use an 85mm prime at f/1.8 

or f/1.4 for this, but any 
telephoto zoom will do. The 
great thing about this trick 
is that you end up with a 

wide-angle view with much 

existing lenses will allow.

LOCK CONTROLS  
TO MANUAL

Every shot needs to use the 
same settings. Use manual 

exposure with the maximum 
possible aperture. Set the 
white balance to a manual 

preset. Focus on the subject’s 
face. Set the focus switch 

to manual so that the focus 
distance is the same for every 
shot (many frames will appear 

out of focus).

SMALL IS 
 BEAUTIFUL

Each tile in your mosaic is 
small, so switch File Type to 

JPEG Basic, and reduce Image 
size to the smallest available. 

This helps to ensure your 
computer doesn’t crash when 
stitching everything together. 

You can also resize images 
further in Photoshop before 

you start stitching.

2

3

1



STEP BY STEP: GET THE BRENIZER EFFECT

S K I L   L   S

SHOOT 
 YOUR TILES

You can compile a Brenizer 
portrait with 80 or more 

pictures, to get a really wide 
view, but to simplify the 

shooting and the stitching 
process, start with 30 shots. 
Shoot your sequence in rows 
from top left to bottom right. 
Make sure each tile and row 
overlaps the last by around 

a third.

ALL LOOKING  
SHARP

Open all the low-res shots for 
your composite in Photoshop. 
Then go to File>Automate> 

Photomerge. Choose Auto from 
the Layout options, ensure 
Blend Images Together is 

selected, and then use the Add 
Open Files option. Click OK and 

the stitching starts.

CHOP OUT THE  
ROUGH EDGES 

The stitching process may take 
a few minutes as the program 
blends the pictures together. 

The resulting composite image 
will need to be cropped to 

but don’t cut any more of 
the blurred foreground and 

background than you need to.

5

6

4



Give soft-looking photo 
subjects more impact
while keeping sharpening 
artefacts at bay

HOW TO...
SHARPEN 
UP YOUR 
IMAGES

L I G H T R O O M
LEARN ESSENTIAL EDITING SKILLS FAST!

E D I T I N G

t can be a challenge to get your 
photos looking pin-sharp for a 
variety of reasons. Many digital 

cameras have a built-in filter that blurs 
the photo a little in an attempt to avoid 
producing moiré patterns. This low-pass 
(or antialiasing) filter can also soften 
important details. Or by placing the 
camera close to a small subject (such 
as a flower), you risk getting a shallow 
depth of field. This means only a narrow 
band of detail will be in focus. 

Fortunately, Lightroom’s Detail panel 
is packed with tools designed to tease 
out fine details. These tools work by 
increasing contrast around the edges of 
fine details, giving them more impact. 

However, when you digitally sharpen 
a photo using Lightroom’s sliders, 
you risk exaggerating picture noise in 
smooth areas such as the clear blue 
background in our starting image. You 
can also introduce artefacts such as 
blown-out highlights, clipped shadows 
and distracting haloes.

In this tutorial we’ll examine ways 
to sharpen your photos while keeping 
artefacts at bay, and demonstrate 
how the sophisticated Detail panel 
enables you to restrict the sharpening to 
important areas of your image.

I

AFTER

BEFORE

WANT TO LEARN HOW TO USE LIGHTROOM FASTER? GET THE WHOLE COURSE NOW!
If you don’t want to wait a whole year to learn how to use Lightroom, you can download our whole course 
from the Photography Week app for just $19.99/£11.99. We’ll be including one part of the course every week 
until the end of the year in the magazine, so the choice is yours: wait and take the course for free, or buy it 
now and learn faster, with all the videos in one place!
http://tiny.cc/0bxaqx

WATCH THE V IDEO 
ht tp : // t iny. cc /g 01j0x

DOWNLOAD THE 
PROJEC T F ILES 
ht tp : // t iny. cc /6y1j0x

ON A P C OR M AC



M I N I  T E S T
We test six tough compact cameras

CANON  
POWERSHOT D30

PRICE: £200 / $300
www.canon.com

We say: A waterproof wonder, but it 
won’t win any prizes for image quality

1

The PowerShot D30’s 25-metre 
waterproof rating may have recently 

been overshadowed by the Nikon 
AW130, but this is still a great diving 
companion. Its ergonomic design 

features oversized controls that make 
the camera easy to operate underwater 
or while wearing gloves. The three-inch 
LCD is also one of the brightest of the 
bunch. However, the rest of the D30’s 
specs are more mundane, and unlike 
the Olympus TG-3 or Panasonic FT5, 
there’s no crushproof rating or Wi-Fi. 
Although detail levels are high and 
there’s little evidence of smearing, 

image noise becomes visible at ISO400.

FUJIFILM 
FINEPIX XP80

PRICE: £123 / $170 
www.fujifilm.eu/uk

We say: Great value, providing you 
accept its compromises

2

Fujifilm’s entry is the cheapest 
here, but it still sports a useful 15m 
waterproof rating and is shockproof 
to 1.75m, while also being dustproof 
and freezeproof. Its 16.4MP sensor 
copes well in good light, but step 

indoors and you’ll see a drop in detail, 
and noise quickly becomes apparent. 

Many tough cameras will also put 
the XP80’s disappointing 210-shot 
(normal shooting) battery life and 
9cm macro mode to shame. Built-

feature are nice touches at this price, 
but they do come at the expense of 

the quality of the camera’s LCD.

NIKON 
COOLPIX AW130

PRICE: £245 / $297 
www.nikon.co.uk

We say: Almost worthy of top honors – 

3

Features are the AW130’s forte. It boasts 
a terrific GPS system, an interactive 

world map and Wi-Fi connectivity, plus 
an altimeter and a depth gauge. It’ll 

also keep up with the action, thanks to 
a fast 7fps burst shooting mode and a 
370-shot (normal shooting) battery life. 
A 30m waterproof rating makes it top of 
the class, and it’ll keep shooting at -10° 
or after a 2.1-metre drop. Downsides? 
There’s no crushproof rating, and the 

image quality can’t match the Panasonic 
FT5. Detail is smeared throughout 

the sensitivity scale, while occasional 
exposure metering and white balance 

inconsistencies can be frustrating.



M I N I  T E S T
We test six tough compact cameras

OLYMPUS 
STYLUS TG-3

PRICE: £314 / $320
www.olympus.co.uk

We say: An outstanding tough camera 
that’s worth every penny

4

The TG-3’s build quality suggests it 
could survive pretty much anything 

you could throw at it. It’ll take a 
drop from 2.1 metres, a -10° freeze, 
100kg of force and 15-metre-deep 
excursions. A chunky, ergonomic 

shape and well-designed controls 
makes the TG-3 a pleasure to use 

in any weather. It’s also packed with 
useful features for when you’re out 
in the wild, such as a GPS system, 
an electronic compass and depth 
and pressure gauges. But while 

daytime shots are easy on the eye, 
low-light images are marred by 

noise and smearing.

PANASONIC 
LUMIX DMC-FT5

PRICE: £200 / $249 
www.panasonic.com

We say: A fine choice if you can’t stretch 
to the Olympus TG-3

5

The FT5 is getting long in the 
tooth, but it can still cut it against 
today’s models. Its 16.1MP sensor 

resolves plenty of detail and 
maintains impressive clarity as 
high as ISO1,600. A 4.6x Leica 

lens provides a 35mm-equivalent 
focal range of 28–128mm, and is 

optically stabilized. The FT5’s 13m 
waterproof rating is nothing special, 

but you can’t knock its ability to 
shrug off a 2m drop, survive -10° 

freezes or withstand a 100kg 
crushing. Factor in GPS, Wi-Fi and 
NFC, and the FT5 shapes up as a 

great all-rounder.

RICOH 
WG-30

PRICE: £176 / $200 
www.ricoh-imaging.co.uk

We say: Not bad for the money, but the 
Fujifilm XP80 is better value

6

Despite being one of the less 
expensive choices here, the WG-
30 will still let you dive down to 
12m, and it will survive a drop 

from up to 1.5m. Inside is a 16MP 
sensor capable of ISO6,400 and 
reasonable image quality, while 

the 5x optical zoom range is also a 
match for pricier rivals. Then there’s 
the 1cm macro mode, with six LEDs 

encircling the lens. However, the 
cost-cutting shows in the 2.7-inch 

screen. The widescreen format 
makes normal 4:3 shots appear 

small, and the restricted viewing 
angles ruin colors.



1975 
Kodak engineer Steven 
Sasson builds the first 
digital stills camera. It 

weighed 6.3kg, took 23 
secs to record a 
black-and-white 

image to cassette 
tape, and had a 
10,000-pixel 

sensor.

1987 
Brothers Thomas and 
John Knoll create an 

image-processing application 
called Display. The program 

was sold to Adobe in 1990 and 
renamed Photoshop.

1990
The Dycam Model 1 

was the first portable, 
commercially available 
digital camera. It cost 

almost $1,000 and had 
a resolution of 320 x 

240 pixels. It could 
store up to 32 

images.
1991

The Kodak DCS-100 was 
the first digital SLR camera. 

It consisted of a Nikon F3 film 
camera connected by cable to 

a shoulder-mounted digital 
storage unit. The kit weighed 

7kg and cost up to 
$25,000. 987 of 

these 1.3 megapixel 
cameras 
were sold.

1994
CompactFlash memory 

cards were introduced by 
SanDisk – with capacities 

between 2-24Mb.

The fixed-lens Apple 
QuickTake 100 offered the 
ability to record eight-color 

640 x 480 pixel images.

1995
The Casio QV-10 was the 
first consumer camera to 

offer an LCD for previewing 
and viewing images.

The Ricoh RDC-1 was the 
first digital stills camera 

to shoot video.
1998

One introduced the 
LightPhase digital back, 
which fitted to 
standard 
medium-
format film 

cameras.

2000
by Sharp and sold in 
Japan by J-Phone, 
was the first mobile 
phone with a built-

in camera.

T I M E L I N E
THE DIGITAL CAMERA IS 40 YEARS OLD THIS YEAR.
TO CELEBRATE WE CREATED THIS TIMELINE OF ITS 

INNOVATIONS AND MILESTONES



2002
Contax starts 

selling the first 
D-SLR with a full-

frame sensor.

2003
the first affordable SLR, costing  

£820 with an 18-55mm lens and a 6.3 
megapixel CMOS sensor. 

The Ritz Dakota Digital was the first single-
use digital camera. It was sold in the USA for 

reusable, and it was withdrawn from sale.

2006
The Olympus E-330 

introduces Live View.

Adobe Photoshop Lightroom 
gets a beta release. Version 

1.0 went on sale the 
following year for £199.

2007
The Apple iPhone 

is released.

2008
The Panasonic Lumix G1 – the 

first compact system camera – is 
released. Its Micro Four Thirds 
system removed the need for 

an SLR’s pentaprism and 
mirror box, creating a 

lighter body.

2009
The Fuji Finepix Real 
3D W1 was the first 

digital stereo camera.

2010
Photo and video-
sharing service 

Instagram launched; 
bought by Facebook for 

$1 billion in 2012.2011
Light-field 

photography was 
introduced with the 
Lytro, enabling you 
to adjust the focus 
after you’ve taken 

the shot.

2014
making for 

the masses 
as consumer 

cameras offer 
4K video 

capability.



DIGITAL CAMERA 
WORLD

A monthly magazine 
that aims to improve 

your photography with 
an inspirational mix of 

amazing images and 
how-to articles.

PHOTOPLUS
PhotoPlus is a monthly 
magazine for Canon 
photographers that 
features expert advice, 
tips and video tutorials 
on all things Canon.

PRACTICAL 
PHOTOSHOP
Improve your Photoshop 
skills with the monthly 
guide to creating 
stunning images.  
Each issue comes with 
expert video lessons.  

TEACH YOURSELF 
PHOTOSHOP 
Transform your 
images with the 

expert tips and advice in 50 
Photoshop video tutorials. 
Discover the power of layers, 
blending modes, raw file 
editing and more with this 
easy-to-follow course.

Check out these other fantastic photography apps for iPad & iPhone

TEACH YOURSELF 
LIGHTROOM  
Unleash the 
creative power 

of the Lightroom digital 
darkroom with this 50-part 
video course. Enhance 
landscapes, master black 
and white, make gorgeous 
portraits and more.

TEACH YOURSELF 
RAW IN 
PHOTOSHOP 
Learn how to 

use Adobe’s professional-
level raw file editor to make 
amazing prints from your 
photos. Every important tool 
in Camera Raw explained in 
detail by our experts.

CREATIVE  
SLR SKILLS 
Learn a 
range of 

new photography skills 
with this 30-part video 
training course designed 
to stimulate your 
creativity and boost your 
photographic confidence.

MORE GREAT MAGAZINES FROM  
THE MAKERS OF PHOTOGRAPHY WEEK

SA P P

N-PHOTO
N-Photo is a monthly 

magazine for Nikon 
photographers, and is 
packed with technique 

and Photoshop video 
lessons every month. 
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